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Circuite Integrate Monolitice pentru Microunde 

Proiect 

Tema de proiectare 

Se proiectează circuite pasive realizate în tehnologia prezentată la curs (Plessey). Se foloseşte 

Sonnet pentru simulare electromagnetică şi Advanced Design System pentru simulare de circuit. La 

sfârşitul semestrului se predă un material care să descrie componenta implementată, analiza de 

convergenţă, schema echivalentă şi detaliile tehnologice - nr. de straturi/model metal etc. - (format 

hard sau electronic pdf/doc) împreună cu fişierele care implementează proiectul în Sonnet (cel mai 

precis proiect din analiza de convergenţă, proiect funcţional - fişierul _X_.son + subdirectorul 

corespunzător _X_ din directorul "sondata", versiunea prezentă în laborator, sau ultima versiune 

evaluativă disponibilă online http://www.sonnetsoftware.com/ ) şi Advanced Design System 

(directorul "*_prj" corespunzator sau arhiva *.zap a proiectului). 

Fiecare temă va conţine dimensiuni fizice pentru condensatorul planar (sandwich) cu poliimidă 

ca dielectric (CPI). 

Grila de notare pentru proiect este descrisă în tabelul următor. 

Nr. Tip componentă Nota  

1 Proiect Sonnet funcţional cu dimensiunea corectă din 

tema individuală 

5 

2 Analiză de convergenţă în Sonnet (minim 3 dimensiuni 

pentru celulă), descrisă în documentele trimise 

+2 

3 Simulare model echivalent în ADS (proiect trimis)  +1 

4 Analiză de optimizare în ADS +1 

5 Document +1 

Tabel 1. Grilă de notare 

Nivelul de precizie necesar pentru nota maximă constă în simularea temei în Sonnet utilizând o 

structură cu 5 straturi (GaAs+Si+PI+Si : Fig. 7a) cu model "Normal metal" (Fig. 2) pentru 

metalizările M2 şi M3. Se acceptă şi utilizarea altor nivele de detaliu în simulare, cu micşorarea 

notei la utilizarea unor modele mai simple (mai rapide în simulare) sau cu creşterea acesteia în cazul 

modelelor mai complexe (dar mai lente): 

Nr. Descriere Variaţie 

notă 

Detalii 

1 Utilizare structură cu trei straturi (GaAs+PI+aer) -1  

2 Utilizare structură cu cinci straturi (GaAs+Si+PI+Si) 0 Fig. 7a 

3 Utilizare structură cu nouă straturi (GaAs+Si+PI+Si) +1 Fig. 7b 

4 Utilizare metal ideal -1  

5 Utilizare model "Normal metal" 0 Fig. 2 

6 Utilizare model "Thick metal" (min. 4 nivele) +2 Fig. 3,4 

7 Utilizare model "Dielectric Brick" +1 Fig. 6,7b 

Tabel 2. Modificare nota 

http://www.sonnetsoftware.com/
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Note:  

 Modele mai complicate presupun creşterea considerabilă a timpului de calcul şi a memoriei 

necesare. 

 Unele combinaţii temă/bonus nu sunt posibile. De exemplu: numai modelarea înălţimii 

metalizărilor ("Thick metal": Fig. 3,4) poate genera utilizarea a nouă straturi dielectrice (Fig. 

7b) şi utilizarea modelului "Dielectric Brick" (Fig. 6,7b) 

 Toate componentele implică utilizarea a două nivele de metalizare (M2 şi M3) şi implică 

apariţia trecerilor între nivele (via-holes) 

Straturile de materiale implicate sunt reprezentate simplificat în figura 1, indicându-se de asemenea 

suprafeţele pe care se depun cele două niveluri de metalizare M2 şi M3 (nitrura de siliciu se depune 

deasupra acestor metalizări pentru a evita conexiuni electrice nedorite). În tabelul 3 sunt prezentate 

caracteristicile materialelor utilizate. 

 
Fig. 1. Straturi dielectrice 

Nr. Material r tan  [S/m] Rsq[mΩ/sq] h[μm] 

1 GaAs 12.85 0.3·10
-3 

  200 

2 Si3N4 7.2 15·10
-3

   0.13 

3 PI 3.4 55·10
-3

   1.8 

4 M2   3.6·10
7
 55 0.5 

5 M3   3.3·10
7
 10 3 

Tabel 3. Caracteristici materiale utilizate 

Pentru descrierea metalizărilor există mai multe nivele de detalii introduse, care sunt recompensate 

prin bonus-uri diferite (tabelul 2). În primul rând modelul utilizat în Sonnet poate fi: 

 Metal Ideal (Lossless), pierderi nule, înălţime egală cu 0 

 Modelarea pierderilor (Normal Metal), mărimile introduse fiind cele din figura 2: , h şi 

raportul de curenţi între suprafaţa de sus şi cea de jos a conductorului. Pierderile sunt 

modelate prin rezistenţe de suprafaţă, raportul de curenţi depinzând de tipul de linii 

introduse. Pentru linii microstrip acest raport este tipic 1.5 . În structura geometrică înălţimea 

introdusă este 0 (valoarea introdusă în model e utilizată strict la calcularea impedanţelor de 

suprafaţă). 

 Modelarea pierderilor şi a înălţimii liniei (Thick metal), mărimile introduse fiind cele din 

figura 3: , h şi numărul de nivele de metalizare introduse pentru simularea înălţimii. În 

structura geometrică înălţimea introdusă este cea indicată şi Sonnet realizează automat 

h GaAs 

h Si 

h PI 

h Si 

M2 

M3 
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secţionarea stratului dielectric de deasupra pentru a introduce efectiv folii metalice în 

structură (fig. 4). Se obţin astfel câteva (NumSheets -1) suprafeţe suplimentare, şi câteva 

straturi suplimentare care permit modelarea mai bună a înălţimii liniei, cu creşterea 

corespunzătoare a timpului de calcul şi a memoriei necesare, ca urmare se recomandă 

creşterea graduală a numărului de nivele (2 - 4 - 6) cu urmărirea necesarului de memorie şi 

cu realizarea unei analize de convergenţă. În această situaţie metalizarea se extinde pe 

verticală şi intră în stratul dielectric de deasupra. 

 
Fig. 2. Modelarea pierderilor (Normal metal model) 

 
Fig. 3. Modelarea grosimii metalizării (thick metal model) 
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Fig. 4. Modelarea grosimii metalizării (4 nivele) 

 
Fig. 5. Geometria reală în circuitul integrat 

Utilizarea modelului "thick metal" oferă apropierea cea mai mare de situaţia reală (fig. 5). 

Suplimentar, înălţimea stratului de pasivizare cu nitrură de siliciu este mai mică decât a metalizărilor 

implicate (0.13μm faţă de 0.5/3μm) ceea ce aduce o dificultate suplimentară la modelarea cu 

precizie a depunerii nitrurii de siliciu pe metalizare. O modelare precisă impune introducerea unor 

straturi suplimentare şi utilizarea modelului "Dielectric Brick". Elementul "Dielectric brick" în 

Sonnet introduce un paralelipiped dintr-un material dielectric în interiorul unui alt material 

dielectric, obligatoriu extins pe întreaga înălţime a stratului dielectric în care se realizează 

introducerea (fig. 6). Introducerea unui bloc dielectric trebuie însoţită de impunerea unei secţionări 

pe verticală a stratului dielectric corespunzător "number of Z-partitions" (în meniu, Circuit -> 

Dielectric Layers -> buton Z-Parts...). Iniţial valoarea este 0 pentru straturile "normale", fără blocuri 

dielectrice, dar trebuie crescut la minim 1 la introducerea unui astfel de bloc, cu creşterea 

corespunzătoare a timpului de calcul şi a memoriei necesare, ca urmare se recomandă creşterea 

graduală a numărului de nivele (1 - 2 etc.) cu urmărirea necesarului de memorie şi cu realizarea unei 

analize de convergenţă.. 
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Fig. 6. Dielectric Brick în Sonnet 

Pentru modelarea nitrurii de siliciu depusă pe metalizare e necesară introducerea suplimentară a 4 

straturi prin împărțirea în trei secțiuni a straturilor de poliimid şi aer (pentru a crea nivelele necesare 

între care să se extindă depunerile de pe metalizare - fig. 7). 

 
Fig. 7. Modelarea pasivizării pe metalizare (5 straturi -> 9 straturi) 

Simulările în Sonnet se realizează între 1 şi 20GHz (corespunzător tehnologiei Plessey) şi se obţin 

pentru utilizarea în analiza de circuit parametrii S pentru dispozitivul analizat. Parametrii S se obţin 

în aplicaţia Response Viewer unde pot fi afişaţi parametrii S, dar exista şi optiunea exportării acestor 

parametri (în meniu, Output > S,Y,Z Parameter File) cu alegerea optiunilor: Format = 

Touchstone, Data Type = De-Embedded, Parameter = S-Param, Complex = Mag-Angle. 

Note 

 E obligatorie creşterea incrementală a complexităţii modelului ales (nr. de straturi, nr. de 

celule, model metal, introducere bloc dielectric, număr de nivele la metalizări şi în blocurile 

h M3 

h Si 

h PI 

h Si 

h M2 

h Si 
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dielectrice), deoarece modelarea "completă" depăşeşte cu mult resursele de timp şi RAM pe 

care le aveţi la dispoziţie 

 Modelarea componentei se face fără introducerea elementelor suplimentare inevitabile în 

practică, dar care sunt caracterizate de modele suplimentare: trecere M2/M3 pentru revenirea 

pe nivelul de metalizare M3, tranziţii de la linia standard de conexiune (12/40μm) la linia 

utilizată în circuit, etc. (fig. 8,9). 

 E necesară adăugarea opţiunii "Add reference planes" (neutilizată la laborator) pentru a 

asigura obţinerea modelului componentei fără a introduce şi liniile (de lungime variabilă) de 

acces (fig. 8,9). 

 Dimensiunile celulelor standard sunt: 

o bobină: lăţimea traseelor 12μm, spaţiul între trasee 12μm, latura trecerilor 40μm, 

diametru trecere (via) M3-M2 circulară cu diametru 30μm, prima spiră din jurul 

trecerii are latura internă 76μm (fig. 9), linia de acces pe M3 are diverse orientări în 

funcţie de numărul de sferturi de spiră din temă. 

o condensatoare: lăţimea liniilor de acces la armături (M2 şi M3) este de 40μm (fig. 8) 

 Modelarea se încheie prin obţinerea modelului de circuit pentru componentă. Această 

operaţiune se realizează de mai multe ori pe parcursul realizării proiectului. Analiza de 

convergenţă presupune urmărirea variaţiei unei mărimi numerice importante din structură, 

iar în cazul componentelor simulate această mărime va fi valoarea componentei (mărimea 

principală, fără componentele parazite, L sau C) 

   
Fig. 8. Modelare condensator, plane de referinţă 
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Fig. 9. Modelare bobină, plane de referinţă 

Modelarea în simulatorul de circuit se realizează în ADS (Advanced Design System, versiunea 2003 

sau 2009). În principiu paşii sunt: 

 modelarea schemei echivalente pentru componentă, prezentată în slide-urile de la curs 

împreună cu relaţiile necesare pentru a calcula valorile iniţiale ale elementelor 

 compararea rezultatului (parametri S) cu rezultatele obţinute în Sonnet 

 variaţia valorilor elementelor din schema echivalentă în vederea suprapunerii în banda largă 

(1-20 GHz) a celor două rezultate 

o în cazul alegerii temei cu bobină există o rezonanţă a parametrului S21 la o frecvenţă 

în interiorul benzii tehnologiei (1-20 GHz). Suprapunerea modelelor se face numai 

până la 80-90% din această frecvenţă 

Programul de simulare utilizat în laborator este Advanced Design System 2003, instalat pe sistemul 

de operare XP Professional. În laborator găsiţi acest sistem pe o maşină virtuală. Detectaţi pe 

desktop icoana care porneşte VMware Player. În interfaţa programului identificaţi maşina virtuală 

"RF XP Professional" sau alegeţi comanda "Open a Virtual Machine" şi căutaţi maşina în directorul 

(tipic) D:\DCMR\WXP_CIM. 

 
Fig. 10. Fereastra principala ADS 
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Fereastra principală a programului - Advanced Design System (Main) (fig. 10) permite gestionarea 

proiectelor (creare, ștergere, arhivare – în scopul transportului unui proiect pe un alt calculator există 

implementată o metodă de arhivare format zip, rezultând un fişier cu extensia "*.zap" care va păstra 

structura internă de directoare a proiectului), accesul la fișierele individuale ale proiectului. Un 

proiect este constituit dintr-un director propriu cu numele "nume ales" + "_prj", aflat în directorul 

ales la instalare, implicit "C:\users\default\" dar calea poate fi modificată (şi cea implicită, de 

instalare, şi individual la crearea unui proiect nou). 

Notă importantă: Salvarea oricărui fişier în alt director decât cel propus de program în interiorul 

directorului proiectului curent (fig. 12) face ca fişierul salvat să fie decuplat de proiect, cu alterarea 

funcţionalităţii (de ex. o schemă salvată în alt director nu va putea fi simulată). 

Pentru a crea un proiect nou utilizaţi din meniu comanda File > New Project. Aceleaşi comenzi pot 

fi aplicate utilizând butoanele din bara de comenzi a programului. În fereastra care apare se 

introduce după calea deja afişata "C:\ users\default\" numele dorit al proiectului fără terminaţia 

"_prj" care va fi adăugată automat de program. Din motive de compatibilitate cu versiunile 

anterioare, este o cerinţă a programului ca orice cale întâlnită în proiect să nu conţină spaţii. Ca 

urmare numele ales pentru proiect trebuie ales fără spaţii, ca şi calea spre director (nu se pot utiliza 

locaţii ca "My Documents" sau "Desktop"). Exemplu: C:\users\default\popescu5401  

 
Fig. 11. Crearea unui nou proiect 

Se creează astfel proiectul respectiv, care este deschis automat. Implicit se creează şi o primă 

schemă, într-o fereastră nouă care poate fi utilizată pentru a desena schema ce urmează a fi simulată. 

În caz că această fereastră nu a fost creată se poate alege butonul   pentru a genera această 

schemă sau comenzile File > New Design din meniu. Este recomandat să se salveze aceasta schemă 

(fereastra [popescu5401_prj] untitled1)  pentru a avea un nume ce poate fi recunoscut. După 

salvare fişierul corespunzător va putea fi găsit în secțiunea networks din structura proiectului 

(fereastra principală - Main - fig. 10,12) în caz că îl veţi închide din greşeală. 

Ca şi Sonnet, ADS este un program multi-fereastră, cu programe individuale care comunică între 

ele, astfel că vă puteţi găsi frecvent în situaţia în care aveţi 4 ferestre deschise simultan (fereastra 

principală, una sau mai multe scheme, simulatorul - fig. 15, programul de vizualizare a rezultatelor - 

fig. 16). 
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Fig. 12. Structura internă (obligatorie) a unui proiect şi introducerea schemei 

ADS are componentele grupate pe palete poziţionate în partea stângă a interfeţei, gruparea fiind în 

funcţie de tipul componentei respective. Pentru introducerea schemei din această lucrare se vor 

folosi paletele (fig. 13): 

 Lumped Components - Elemente concentrate (RLC) 

 Simulation S_Param - elementele de control al analizei, parametri S în acest caz, deoarece 

analiza electromagnetică cu care se compară schema oferă numai aceşti parametri 

 Data Items - pentru introducerea rezultatelor analizei electromagnetice, un diport caracterizat 

prin fişierul cu parametri S obţinut în Sonnet 

 Optim/Stat/Yield/DOE pentru implementarea algoritmilor de variaţie a elementelor din 

schemă 

Elementele comune, des întâlnite pot fi accesate din bara de butoane a programului de desenare a 

schemei (masa, fire, variabile, etc.) 

    
 

 
Fig. 13. Palete utilizate în realizarea schemei  
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Se introduce schema (din fig. 14) prezentată la curs, valorile iniţiale fiind obţinute cu ajutorul 

relaţiilor de la curs (schema şi valorile sunt diferite în funcție de tema aleasă). 

 
Fig. 14. Verificarea schemei echivalente pentru comparaţia cu rezultatul analizei electromagnetice  

Nota1: Are importanţă poziţionarea corectă a porturilor astfel încât să corespundă cu notaţia 

porturilor în Sonnet, mai ales la schemele asimetrice (bobină şi condensator PI). De exemplu în 

figurile 8,9 în Sonnet şi 14 în ADS portul 1 (elementul Term cu "Num = 1") este pe nivelul de 

metalizare M3 iar portul 2 este pe nivelul M2. 

Nota2: Chiar dacă unele valori pot fi modificate direct pe schemă, se recomandă utilizarea interfeţei 

proprii pentru fiecare element pentru introducerea valorilor, interfaţă accesibilă prin dublu-click pe 

elementul respectiv. 

Urmează simularea efectivă , sau F7 sau comanda din meniu Simulate > Simulate. Deoarece 

este o simulare de circuit, cu modele corespunzătoare dispozitivelor, vă puteţi aştepta ca simularea 

să dureze puţin, de ordinul secundelor. Fereastra simulatorului prezentată mai jos (fig. 15) rămâne 

deschisă. Urmăriţi mesajele pentru a identifica un eventual mesaj de eroare. Dacă e cazul, încercaţi 

să îl interpretaţi şi să corectaţi eroarea, în caz de insucces apelaţi la ajutorul cadrului didactic.  



 

11 

 

 
Fig. 15. Simulatorul ADS 

 
Fig. 16. Programul de vizualizare ADS 

După terminarea cu succes a analizei se va deschide fereastra de vizualizare a rezultatelor (fig. 16). 

Vă interesează să reprezentaţi parametrii S pentru rezultatele din Sonnet şi pentru schema 

echivalentă, pe acelaşi grafic, deci veţi alege în momentul plasării graficului rectangular pe ecran 

S(1,1) şi reprezentarea modulului (în dB). Se compară reflexia la intrare, nivelul de metalizare M3, 

pentru ambele scheme (portul 1 pentru schema echivalentă, portul 3 pentru parametrii S importaţi) 

deci S33/S11, şi transmisia între intrare şi ieşire (ieşirea e pe nivelul de metalizare M2, portul 2 pentru 

schema echivalentă, portul 4 pentru parametrii S importaţi) deci S43/S21 (fig. 17). 
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Fig. 17. Compararea simulării de circuit cu simularea electromagnetică pentru condensator PI 

Scopul analizei va fi determinarea valorilor de componente care să conducă la suprapunerea cât mai 

exactă a celor două grafice. Această metodă de generare a modelelor poate fi la modul general 

aplicată şi dacă setul de referinţă este obţinut în urma măsurătorilor şi nu din simulări 

electromagnetice. 

Algoritmii de optimizare necesită: 

 indicarea elementelor care urmează a fi modificate,  

 alegerea unei metode de modificare/mod de calculare a abaterii faţă de ţintă, şi  

 indicarea obiectivului ce trebuie atins (goal)  

Pentru a indica ce elemente trebuiesc modificate, se accesează interfaţa proprie fiecărui element (R, 

L, C - fig. 18 - butonul "... Optimization ...") şi apoi interfaţa de optimizare, unde trebuie activat 

("Enabled") respectiva componentă/valoare, urmat de limitarea intervalului de variaţie al 

componentei (posibilitatea variaţiei nelimitate - "Unconstrained" - deşi existentă în interfaţă, nu este 

recomandabilă într-un procedeu de optimizare). Ţinând cont de faptul că relaţiile de la curs oferă 

deja nişte valori estimate, se poate defini în jurul lor un interval (min/max) sau o abatere procentuală 

sau absolută în jurul valorii de start. Alegerea (fig. 18) a unui interval, are avantajul obţinerii unor 

limite cu valoare numerică "rotundă" uşor de remarcat în situaţia în care o componentă ajunge să 
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atingă aceste valori în urma procesului de optimizare (situație care indică necesitatea schimbării 

intervalului). 

   
Fig. 18. Definirea variabilelor şi a intervalului de variaţie ADS 2003/2009 

Se remarcă faptul că versiunile de ADS de după ADS 2009 beneficiază suplimentar de o variantă 

îmbunătăţită de a vizualiza şi modifica variabilele utilizate în procesele de optimizare, accesibilă din 

meniu Simulate > Simulation Variables Setup (fig. 19) 

 
Fig. 19. Definirea variabilelor şi a intervalului de variaţie (ADS 2009) 

După indicarea elementelor ce urmează a fi modificate, în schemă (fig. 20) acestea vor putea fi 

identificate ca fiind incluse în procesul de optimizare (valoarea elementului este urmată de opt, 

împreună cu indicaţii ale intervalului de variaţie). Din paleta Optim/Stat/Yield/DOE (fig. 13) se 

introduce controler-ul de simulare corespunzător (OPTIM), care, împreună cu indicarea obiectivelor 

procesului de optimizare, va completa schema utilizată în procesul de optimizare (fig. 20). 
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Fig. 20. Introducerea procedurii de optimizare (de suplimentat cu S22) 

Pentru controler-ul de optimizare trebuie indicate (fig. 21) metoda de optimizare utilizată (pentru 

problema curentă metodele Gradient sau Random sunt suficiente), variabilele şi obiectivele care se 

utilizează în algoritm şi numărul (maxim) de iteraţii care trebuie realizate pentru a ajunge la rezultat.  

    

 
Fig. 21. Controlul procedurii de optimizare 

În secţiunea "Parameters" se specifică care sunt datele care trebuie salvate (iniţiale, intermediare, 

finale), dacă programul de vizualizare asociat va fi activ în timpul simulării sau nu, dacă trebuie 

realizată o analiză cu valorile finale obţinute la optimizare. Activarea salvării unor date intermediare 
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sau finale e necesară poate în etapa realizării proiectului pentru că permite urmărirea evoluţiei 

procesului (permiţând eventual oprirea a unei analize care nu se desfăşoară în direcţia necesară). 

Obiectivele pentru algoritmul de optimizare (pot fi oricât de multe, dar creşterea numărului acestora 

mai mult decât este necesar pentru rezolvarea problemei poate încetini sau chiar face imposibilă 

obţinerea unui punct optim) se introduc prin introducerea elementului "Goal" din aceeaşi paletă 

Optim/Stat/Yield/DOE (fig. 13). Elementul "Goal" e caracterizat de o expresie matematică "Expr" 

care nu trebuie să scadă sub valoarea "Min" sau să crească peste valoarea "Max" când variabila 

independentă "RangeVar" (tipic această variabila este frecvenţa - "freq") variază între "RangeMin" 

şi "RangeMax". Pot fi mai multe variabile independente dacă problema de rezolvat o necesită. 

În cazul temei curente, se ţine cont de faptul că parametrii S sunt numere complexe, caracterizate de 

modul şi fază, deci pentru fiecare parametru care se cere modelat în schemă apar două obiective, 

unul în care expresia caracterizează abaterea modulului, un al doilea în care expresia caracterizează 

abaterea fazei. Ţinând cont că schema implementată e un circuite reciproc (fără circuite active, 

ferite) S12 = S21 , deci condiţiile de coincidenţă trebuie puse doar pentru 3 parametri: S11 , S21 şi S22 

(S22 nu apare în fig. 20 dar intervine cu două obiective la fel ca ceilalți parametri S). Pentru a uşura 

modificarea simultană a tuturor obiectivelor se foloseşte un bloc VAR pentru a defini variabile 

pentru eroare modul (dmag), eroare fază (dphs), frecvenţă minimă (fmin), frecvenţă maximă (fmax). 

O schimbare în acest bloc va fi automat transferată la toate cele 6 elemente obiectiv "Goal". 

Valorile obţinute în urma procesului de optimizare pot fi afişate (varianta recomandată este sub 

formă tabelară - fig. 22) şi pot eventual fi preluate în schemă cu comanda Simulate > Update 

Optimization Values (comandă necesară doar dacă se utilizează mai departe aceste valori, în alte 

condiţii fiind preferabilă păstrarea valorilor iniţiale în schemă pentru realizarea unei scheme 

echivalente pentru un alt set de parametri S). Numărul de iteraţii parcurse poate furniza informaţii 

importante. Astfel, optimizarea cu metode de gradient caută un minim al obiectivelor pentru toată 

gama de frecvenţă, în mod normal la atingerea acestuia procedeul se opreşte. Încheierea cu succes a 

acestui algoritm se poate observa dacă numărul de iteraţii parcurs e mai mic decât cel indicat la 

pasul anterior (fig. 21). În caz contrar trebuie repetată simularea cu un număr mai mare de paşi, sau 

cu intervale mai largi pentru componente, sau cu abatere permisă mai mare. Dimpotrivă la 

optimizarea cu metode aleatorii (Random) se parcurg toţi paşii indicaţi, fără condiţii de oprire, deci 

numărul de iteraţii trebuie să fie egal cu cel maxim. 

 
Fig. 22. Valorile optimizate din schema echivalentă pentru condensator PI 

Fie prin realizarea unei analize de parametri S finale (fig. 21) fie prin preluarea în schemă a valorilor 

optimizate şi realizarea manuală a unei analize de parametri S, se poate verifica potrivirea între 

seturile de parametri S (fig. 23) şi obţine modelul echivalent al componentei simulate/măsurate (fig. 

24). 
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Fig. 23. Rezultatele optimizării pentru condensator PI 

 
Fig. 24. Modelul final pentru condensatorul PI 

Exemplu de proiectare 

Să se proiecteze un condensator planar (sandwich) cu poliimidă cu latura armăturii de X μm. 

Se încearcă obţinerea notei maxime, deci la nota de bază 6p se adaugă bonus-urile pentru "Utilizare 

structură cu nouă straturi" (+1p, Fig. 7b), "Utilizare model Thick metal" (+2p, Fig. 3,4) şi "Utilizare 

model Dielectric Brick (+1p, Fig. 6,7b). 

Se desenează structura în Sonnet conform indicaţiilor anterioare. Structura de bază va fi cea 

corespunzătoare complexităţii maxime ţintite (Fig. 7b), fiind relativ uşor de eliminat straturi, blocuri 

dielectrice, modificat model de metal pentru a realiza analize simplificate. 

O primă alegere care trebuie realizată este cea a dimensiunii celulei, deoarece desenarea se face prin 

nodurile unui grilaj existent. În acest moment trebuie ţinut cont de cum va fi modificată celula pe 

viitor, deoarece la modificarea celulei se schimbă şi grilajul asociat, şi e mai comod ca structura 
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desenată să se potrivească şi cu grilajele viitoare, evitând astfel desenarea din nou a structurii de 

fiecare dată. 

Se alege celula cea mai mare preconizată a fi utilizată ca divizor al laturii armăturii şi a altor 

dimensiuni din structură, chiar dacă numerele rezultate nu vor fi tocmai "rotunde". În continuare 

orice înjumătăţire a celulei va păstra desenul ancorat pe grilaj. 

 
Fig. 25. Alegerea dimensiunii maxime a celulei 
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Dacă structura o impune, celulele nu trebuie neapărat să fie pătrate, discuţia fiind similară dar 

separată pe cele două direcţii, apărând două grade de libertate suplimentare  
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Se reaminteşte puterea "magică" a puterilor lui 2 în ceea ce priveşte alegerea unei dimensiuni 

iniţiale. Se recomandă îndeplinirea, dacă e posibil, ca fiecare din valorile întregi ale rapoartelor din 

relaţiile anterioare (k, l, m, p, q, r, s) să fie o putere a lui 2. În acest caz, dacă alegerea iniţială se 

dovedeşte a fi prea mică, este posibilă dublarea dimensiunii celulei de un număr de ori (variabil) cu 

păstrarea condiţiei de ancorare a desenului structurii pe nodurile grilajului. 
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Regulile amintite creează o serie geometrică pentru dimensiunile celulei, utilizând 2 ca bază. Orice 

număr întreg poate fi folosit ca bază, dar utilizarea unui număr mai mare duce la obţinerea unei 

scăderi a celulei mult prea rapidă care creşte prea brutal memoria şi timpul necesare pentru analiză 

(ex: 1,2,4,8,16… / 1,3,9,27,81…) 

Notă importantă: Sub nici un motiv nu se dezactivează opţiunea Snap (din meniu Tools > Snap 

Setup sau - mai uşor de apăsat din greşeală - din butonul din bară). Dacă nu se poate desena 

dimensiunea dorită pe grilajul curent, e un semn că alegerea iniţială a celulei a fost greşită. 

Pentru schema realizată se alege celula cea mai mare de dimensiune 8μm, pătrată, cu îndeplinirea 

condiţiilor anterioare. Vom putea apoi micşora celula prin înjumătăţire (4μm, 2μm, 1μm, 0.5μm) 

fără a mai fi necesară redesenarea structurii. Se utilizează frecvent comanda View > View 3D pentru 

a verifica poziţionarea corectă a elementelor (Fig. 26 - după direcţia Z scala este exagerată pentru 

observarea detaliilor subţiri). 

 
Fig. 26. Structura desenată: 9 straturi (8 nivele), Thick Metal, Dielectric Brick 

Urmează realizarea unei analize de convergenţă pentru a determina nivelul de detalii necesar de a fi 

introdus în analiză. Mărimea primară de interes pentru dispozitivul simulat este capacitatea primară. 

Pentru fiecare analiză electromagnetică se vor salva parametri S într-un fişier Touchstone care va fi 

folosit în ADS pentru optimizarea schemei echivalente şi obţinerea parametrilor din schemă. 

Valorile calculate cu relațiile din curs pentru modelul echivalent (valorile de start din ADS) sunt 

cele din figura 14: 
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E momentul să menţionăm că ţinta analizelor nu va fi să obţinem exact aceste valori prin simulare, 

deoarece caracteristicile tehnologiei Plessey ar putea să fie puţin diferite de caracteristicile 

menţionate în tabelul 3. 

Investigarea efectului modelării metalizărilor se face pentru o structură cu celula de 4μm, cu 

modelul Thick metal cu un număr variabil de folii metalice (NS = 2,4,8,16), pe o structură fără 

utilizarea blocurilor dielectrice (Si3N4 aplicat pe metalizări) pentru accelerarea analizelor. Vom 

verifica şi situaţia utilizării unor modele mai puţin performante pentru metalizări (NS = 0, metalizare 

ideală - LossLess - sau normală - Normal Metal). Pentru aceste modele, trebuie să ţinem cont de 

dispariţia înălţimii metalizărilor, care nu sunt neglijabile, acest lucru putând fi realizat prin 

eliminarea straturilor de dielectric de înălţime h PI 1 = h M2 − h Si şi h a 1 = h M3 − h Si din figura 7b. 

Deoarece mărimea capacităţii unui condensator planar depinde explicit de distanţa dintre armături, 

în acest mod asigurăm cu aproximaţie aceeaşi înălţime de poliimidă între acestea. Rezultatele 

analizei de convergenţă sunt prezentate în tabelul 4 şi figura 27. 

Nr Cell [μm] NS NZ Mem. [MB] Timp/f [s] C_PRIME [pF] Obs. 

1 4 0 0 8 1 0.8155 0 (LL) 

2 4 0 0 8 1 0.8157 0 (NM) 

3 4 2 0 49 6 0.8491 2 (TM) 

4 4 4 0 94 13 0.8492 4 (TM) 

5 4 8 0 226 42 0.8492 8 (TM) 

6 4 16 0 662 170 0.8493 16 (TM) 

Tabel 4. Analiză de convergenţă, caracteristici metalizări 

 
Fig. 27. Analiză de convergenţă, caracteristici metalizări 

Analiza de convergenţă arată importanţa utilizării modelului "Thick Metal", dar demonstrează de 

asemenea faptul ca un număr de două nivele de metalizare ar fi suficiente pentru structura analizată 

(cu mai multe nivele apare o variaţie a capacităţii dar nu este esenţială). Vom alege totuşi 4 nivele de 

metalizare pentru a îndeplini condiţiile de obţinere a punctelor bonus. 
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Investigarea dimensiunii celulei necesară pentru analiză va fi făcută de asemenea în lipsa blocurilor 

dielectrice aplicate pe metalizări pentru accelerarea analizelor. Rezultatele sunt prezentate în tabelul 

5 şi figura 28. Se observă că variaţia capacităţii determinate este de ordinul 0.5% între celula de 8μm 

şi cea de 0.5μm deci o dimensiune de 8μm ar putea fi suficientă. Totuşi celulele fixate în planele de 

metalizare vor genera secţionare corespunzătoare şi a blocurilor de dielectric care vor fi aplicate pe 

metalizări. Avem anumite informaţii legate de necesităţile de memorie şi timp de calcul şi o 

indicaţie relativ la valoarea aproximativă a celulei care trebuie utilizată (~4μm) dar o decizie 

definitivă trebuie luată cu structura completă (inclusiv cu blocurile de dielectric) 

Nr Cell [μm] NS NZ Mem. [MB] Timp/f [s] C_PRIME [pF] 

1 8 4 0 46 6 0.8483 

2 4 4 0 94 13 0.8492 

3 2 4 0 196 42 0.8506 

4 1 4 0 422 175 0.8519 

5 0.5 4 0 910 795 0.8530 

Tabel 5. Analiză de convergenţă, dimensiune celulă, fără "Dielectric Brick" 

 
Fig. 28. Analiză de convergenţă, dimensiune celulă, fără "Dielectric Brick" 

Investigarea efectului partiţionării pe verticală a straturilor de dielectric care vor conţine blocuri 

dintr-un alt dielectric (model "Dielectric Brick") se face cu o dimensiune a celulei mare (8μm), 

pentru a nu genera analize excesiv de lungi şi consum excesiv de mare de memorie. Rezultatele sunt 

prezentate în tabelul 6 şi figura 29. Se observă importanţa deosebită pe care o are introducerea 

blocurilor de dielectric (în principal stratul depus pe metalizarea M2 care joacă rol de dielectric 

dintre armăturile condensatorului), în schimb pentru această structură particulară partiţionarea 

suplimentară pe verticală a blocului în 2 sau mai multe nivele nu aduce deloc modificarea 

rezultatelor. Deci blocurile de dielectric vor trebui să apară dar nu este necesar să fie partiţionate 

suplimentar, e suficient Z Parts = 1. 
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Nr Cell [μm] NS NZ Mem. [MB] Timp/f [s] C_PRIME [pF] Obs. 

1 8 4 0 46 6 0.8483 fără Dielectric Brick 

2 8 4 1 150 13 0.8882  

3 8 4 2 272 22 0.8882  

4 8 4 4 629 60 0.8882  

Tabel 6. Analiză de convergenţă, partiţionare pe verticală a "Dielectric Brick" (Z Parts) 

 
Fig. 29. Analiză de convergenţă, partiţionare pe verticală a "Dielectric Brick" (Z Parts) 

În acest moment se cunoaște că e nevoie de metalizare "Thick Metal" cu 4 nivele de metalizare, 

blocuri de dielectric fără secţionare suplimentară (Z Parts = 1) şi o dimensiune a celulei de ordinul 

8-4-2μm. O analiză de convergenţă pe structura completă (figura 26) este necesară pentru o decizie 

finală asupra dimensiunii celulei. Rezultatele unei astfel de analize sunt prezentate în tabelul 7 şi 

figura 30. Se utilizează mărimile (Num. Sheets şi Z Parts) determinate anterior şi se variază 

dimensiunea celulei. Variaţia se opreşte la celulă pătrată cu latura de 2μm, necesarul de memorie 

pentru a realiza analiza cu o celulă de 1μm fiind prea mare pentru a efectua calculele (61565MB). 

Variaţia capacităţii primare de la 8 la 2μm este foarte mică (0.24%) deci inclusiv analiza cu celulă 

de 8μm oferă valoarea acestei capacităţi cu precizia dorită. 

Nr Cell [μm] NS NZ Mem. [MB] Timp/f [s] C_PRIME [pF] 

1 8 4 1 150 13 0.8882 

2 4 4 1 724 80 0.889 

3 2 4 1 5540 2012 0.8904 

Tabel 7. Analiză de convergenţă, dimensiune celulă, cu "Dielectric Brick" 
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Fig. 30. Analiză de convergenţă, dimensiune celulă, cu "Dielectric Brick" 

Putem păstra ca analiză finală pe cea corespunzătoare celulei de 2μm deoarece: 

 a fost deja realizată 

 chiar dacă precizia de determinare a capacităţii nu a fost prea mult îmbunătăţită, un efect se 

poate observa la nivelul elementelor parazite din schemă. 

Reprezentarea valorilor elementelor parazite pentru toate analizele menţionate anterior sunt 

prezentate în tabelul 8 şi figura 31. 

Nr Cell [μm] NS NZ LM2 LM3 CM2 CM3 R 

1 8 4 0 0.02998 0.04836 0.06003 0.002304 1.459 

2 4 4 0 0.02969 0.04786 0.06016 0.002467 1.47 

3 2 4 0 0.0295 0.0476 0.06019 0.002602 1.476 

4 1 4 0 0.02958 0.04747 0.06021 0.002671 1.485 

5 4 0 0 0.02721 0.05065 0.06088 0.001595 1.648 

6 4 0 0 0.03019 0.04919 0.06013 0.001923 1.371 

7 4 0 0 0.02745 0.05059 0.06093 0.001625 1.734 

8 4 0 0 0.0304 0.04916 0.06018 0.001952 1.455 

9 4 2 0 0.02989 0.04784 0.06014 0.002482 1.475 

10 4 8 0 0.0297 0.04778 0.06018 0.002467 1.487 

11 4 16 0 0.02977 0.04773 0.06019 0.002467 1.512 

12 8 4 1 0.03094 0.04772 0.05982 0.002447 1.366 

13 4 4 1 0.03067 0.04721 0.05996 0.002613 1.378 

14 2 4 1 0.03046 0.04697 0.06001 0.00273 1.383 

15 8 4 2 0.03094 0.04772 0.05982 0.002447 1.366 

16 8 4 4 0.03094 0.04772 0.05982 0.002447 1.366 

17 0.5 4 0 0.02963 0.04738 0.06023 0.002692 1.491 

Tabel 8. Analiză de convergenţă, valori elemente parazite 
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Fig. 31. Analiză de convergenţă, valori elemente parazite 

Se observă că valorile elementelor parazite sunt consistente între analize pentru elementele reactive, 

cu excepţia pierderilor în structură caracterizate de rezistenţa serie, a cărei valori depind destul de 

mult de modelarea pierderilor prin metalizări şi de prezenţa pasivizărilor de Si3N4 aplicate pe 

metalizări (reprezentare pe axa secundară din dreapta în fig. 31). Mai ales valoarea rezistenţei 

beneficiază de micşorarea celulei la 2μm (index 14 în tabelul 8), rezistenţa crescând cu 1.25% faţă 

de analiza cu 8μm celulă. 

Note finale 

 Pentru interpretarea timpului necesar pentru analiză şi scalarea acestui exemplu la sistemul 

de calcul propriu: analizele au fost realizate pe un sistem cu două microprocesoare fizice 

X5450 @ 3.00GHz, fiecare microprocesor având 4 nuclee fizice distincte. Fiecare din cele 8 

nuclee a fost folosit în proporţie de 100% pe parcursul analizelor. Memoria fizică prezentă: 

FB-DDR2, 32GB @ 333MHz, sistem de operare Windows 7, 64 biţi. 

 Optimizările în Advanced Design System au fost realizate folosind metoda "Gradient", 

Number of  Iterations:1000, dmag:0.01, dphs:0.1 . Valorile obţinute nu sunt mai precise (în 

limita atinsă la analize: 1%) şi nu justifică obligatoriu alegerea acestei metode pentru 

optimizare. A fost aleasă deoarece spre deosebire de utilizarea analizei "Random" rezultatele 

sunt repetabile (fără implicarea numerelor aleatorii). În general se poate utiliza fără probleme 

"Random" cu un număr mai mare de iteraţii (10000) deoarece algoritmul de optimizare este 

mult mai rapid. 

 Majoritatea timpului total de analiză a fost folosit pentru cele două analize cu necesar de 

memorie ridicat, ca urmare recomandarea de a realiza majoritatea analizelor de convergenţă 

pe modele simplificate la maxim oferă un câştig de timp destul de ridicat. În exemplul 

prezentat se observă că la investigarea unui parametru (C, NS, NZ) ceilalţi doi sunt reduşi la 

minimul posibil. 

 Respectarea iniţială a indicaţiilor cu privire la alegerea dimensiunilor celulei în funcţie de 

dimensiunile fizice din circuit şi relativ, pe cât posibil, la puterile lui 2, reduce extrem de 



 

24 

 

mult timpul consumat cu desenarea schemei pentru multiplele structuri din analiza de 

convergenţă. 

 Simulatorul din Sonnet are prevăzută funcţionalitatea de rulare automată, succesivă a mai 

multor proiecte (fig. 32 - butonul Batch List). Se pot salva mai multe proiecte fără a realiza şi 

simularea (diverse dimensiuni de celulă, număr de straturi, de nivele de metalizare etc.), iar 

cu "Add Project" se pot adăuga în listă, chiar şi în timp ce un alt proiect este analizat. Acest 

lucru oferă posibilitatea de a folosi timpul în care calculatorul simulează un proiect pentru a 

desena un altul şi a-l adăuga la listă ş.a.m.d. (! util mai ales dacă simulatorul nu reuşeşte să 

folosească 100% toate procesoare existente) 

 Informaţiile despre Memorie/Timp se pot obţine din simulator > butonul "Timing Info" sau 

după simulare, din orice program din suita Sonnet din meniu: "Project > View Log > Timing 

Info" 

 
Fig. 32. Simulator Sonnet em, listă de proiecte (Batch List) 

 


